A Review of Eight Software Packages for Structural Equation Modeling

A. Narayanan

This article reviews eight different software packages for linear structural equation modeling. The eight packages—Amos, SAS PROC CALIS, R packages sem, lavaan, OpenMx, LISREL, EQS, and Mplus—can help users estimate parameters for a model where the structure is well specified. Capabilities for handling single group, multiple group, nonnormal variables, and missing data are considered and the eight packages are compared across a variety of criteria from documentation to parameter estimation. The main difference between the packages is the presence of a graphical interface for model specification and presentation of results. Each package differs in terms of strengths, areas of improvement, and unique features that may dictate the choice of selection. Some suggestions on areas of improvement for all software packages are made. This article has supplementary materials online.

KEY WORDS: Analysis of moment structures; Confirmatory factor analysis; Covariance structure analysis; Latent variable modeling; Linear structural relations; Path analysis.

Software Reviewed:

Amos 18: Available from IBM; phone: +1-312-651-3000; fax: +1-312-675-2140; e-mail: salesbox@us.ibm.com; website: http://www-01.ibm.com/software/analytics/spss/products/statistics/

SAS PROC CALIS (version 9.22): Available from SAS Institute Inc., 100 SAS Campus Drive, Cary, NC, 27513-2414, USA; phone: +1-919-677-8000; fax: +1-919-677-4444; e-mail: mcenter@sas.com; website: http://www.sas.com

R package sem (2.1-1): Available from CRAN R-project website: http://cran.r-project.org/web/packages/sem/index.html

R package lavaan (0.4-11): Available from CRAN R-project website: http://cran.r-project.org/web/packages/lavaan/index.html

R package OpenMx: Available from http://openmx.psyc.virginia.edu/installing-openmx

LISREL 8.80: Available from Scientific Software International Inc., 7383 N. Lincoln Avenue, Lincolnwood, IL, 60712-1747, USA; phone: +1-847-675-0720; fax: +1-847-675-2140; e-mail: sales@ssicentral.com; website: http://www.ssicentral.com

Mplus 6.11: Available from Muthen & Muthen, 3463 Stoner Avenue, Los Angeles, CA, 90066, USA; phone +1-310-391-9971; fax: +1-310-391-8971; website: http://www.statmodel.com


1. INTRODUCTION

Structural equation modeling (SEM) is a flexible class of models that allows for modeling complex relationships between variables that are either observed (manifest variables) or unobserved (latent variables). It can be thought of as a combination of factor analysis models (called measurement models) and regression models (called structural models). The motivation behind this structure is that manifest variables are usually measured with error and factor analysis models are able to account for this measurement error; then, the true structural relationship between the variables devoid of measurement error is modeled through regression models among the latent variables. In the social and behavioral sciences, such models are sometimes called “causal” models; the terminology is unfortunate since these models do not establish causality but only test proposed relationships between the variables under study (see Friedman 1987). Although much of the development of SEM has taken place in the social and behavioral sciences, SEM research and reviews have been published in mainstream statistics journals and book chapters (see Yuan and Bentler 1997, 2007; Steiger 2001; Sanchez et al. 2005, and references therein).

The software packages reviewed here use what are known as the LISREL, reticular action model (RAM), and Bentler–Weeks representations. In the popular LISREL notation, the structural model is represented as

$$\eta = B\eta + \Gamma\xi + \zeta,$$

where $\eta$ and $\xi$ are vectors of latent dependent and independent variables, $B$ and $\Gamma$ are regression coefficient matrices, and $\zeta$ is a
vector of latent error variables. The corresponding measurement equations are given by
\[
y = \Lambda_y \eta + \varepsilon, \quad (2)
\]
\[
x = \Lambda_x \xi + \delta, \quad (3)
\]
where \( y \) and \( x \) are vectors of observed variables of latent vectors \( \eta \) and \( \xi \); \( \Lambda_y \) and \( \Lambda_x \) are regression coefficient matrices in the respective equations; and \( \varepsilon \) and \( \delta \) are errors in the measurement equations. The model hypothesis can be written as
\[
\Sigma = \Sigma(\theta), \quad (4)
\]
where \( \Sigma \) represents the population covariance matrix, \( \Sigma(\theta) \) represents the model-implied covariance matrix, and \( \theta \) represents the vector of all parameters to be estimated that includes the coefficient matrices and the covariance matrices of error terms. To analyze a model, one usually begins with a path diagram relating the observed variables and the latent variables using Equations (2) and (3) and the latent variables to each other using Equation (1). Following model specification and identification, the next step is estimation. To estimate the parameters, a fit function is defined and optimized with respect to \( \theta \):
\[
Q = (S - \sigma(\theta)\Sigma^{-1}W(S - \sigma(\theta))), \quad (5)
\]
where \( S \) is the sample covariance matrix written in vector form, \( \sigma(\theta) \) is the corresponding vector of the model-implied covariance matrix, and \( W \) is an appropriate weight matrix. In SEM estimation, techniques vary by choice of \( W \) (see Jöreskog and Sörbom 1996a). Another method of model specification that is used in the R packages sem and OpenMx is the RAM proposed by McArdle (1980) and McArdle and McDonald (1984). In this specification, the manifest variables and the latent variables are organized into a single vector \( v \) and the model is represented as
\[
v = Av + u,
\]
where \( A \) is the parameter matrix, \( I - A \) is nonsingular, \( u \sim N(0, P) \), and \( u \) and \( v \) are independent. The model-implied covariance matrix is
\[
\Sigma(\theta) = J(I - A)^{-1}P(I - A)^{-1T}J^T,
\]
where \( J \) is the selection matrix that chooses the observed variables. It is easy to show that this representation is same as the LISREL representation (see Timm 2000).

In the Bentler–Weeks representation used by EQS, the model is represented as
\[
\eta = B\eta + \Gamma\xi,
\]
where \( \eta \) is a vector of dependent variables (DV), \( \xi \) is a vector of independent variables (IV) that includes error terms, \( B \) is a matrix of regression coefficients between DVs, and \( \Gamma \) is a matrix of regression coefficients among IVs. Variances and covariances among all IVs are estimated. Note that the \( B \) and \( \Gamma \) in the Bentler–Weeks model include the measurement component and are not of the same size as the LISREL model. It is interesting to note that if \( \Gamma = I \), the Bentler–Weeks representation reduces to the RAM representation.

1.1 Scope of the Review

SEM has lately been expanded to include several new methods. Generalizing the concept of latent variable by including continuous, categorical, and a combination of the two opens up a range of different models. This includes conventional SEM, growth curve modeling, multilevel modeling, latent class analysis with and without covariates, latent transition analysis, finite mixture modeling, latent profile analysis, and growth mixture modeling. Using a general latent variable framework, Muthen (2002) unified these methods and implementation using a single software system (Mplus), which is unique to these developments. Due to space limitations, this review will focus attention on the conventional SEM using continuous latent variables.

2. THE EIGHT SEM SOFTWARE PACKAGES

The eight software packages considered are
- R package sem (version 0.9-20), available from http://cran.r-project.org/web/packages/sem/index.html.
- R package lavaan (version 0.4-11), available from http://cran.r-project.org/web/packages/lavaan/index.html.

While previous reviews in this journal have considered Amos or EQS, this is the first review where all the eight software packages are considered together. This review excludes nontraditional alternatives to SEM such as partial least squares. These eight packages were chosen since they include a mixture of commercial and freeware packages. Only the windows version of all these programs is considered here for review. Further description of each software package can be found in Section 2 of the online supplementary materials.

3. DOCUMENTATION

and Sorbøm 1996a), PRELIS 2: User’s Reference Guide (Jöreskog and Sorbøm 1996c), LISREL 8: Structural Equation Modeling With the SIMPLIS Command Language (Jöreskog and Sorbøm 1996b), LISREL 8: New Statistical Features (Jöreskog et al. 2001), and Interactive LISREL: User’s Guide (du Toit and du Toit 2001); Mplus—Mplus User’s Guide (Muthen and Muthen 1998–2010); and EQS—user’s guide (Bentler and Wu 2002) and program manual (Bentler 2006). The documentation for each of these packages was comprehensive and user-friendly. Details of the documentation for each software package can be found in Section 3 of the online supplementary materials.

4. DATA ENTRY AND DATA MANAGEMENT

Data entry and data management capabilities are extensive and varied among the software packages reviewed. The data management capabilities of Amos are very specific and are the most limited, while those of EQS are the most extensive. Details of the capabilities for each software package can be found in Section 4 of the online supplementary materials.

5. CAPABILITIES FOR SINGLE-GROUP ANALYSIS

The focus of this section is to explore the capabilities of the different software packages for conducting a single-group analysis of a general SEM using the observed and latent variables.

5.1 Description of the Data

The data for the single-group analysis illustrate the relationship between political democracy and industrialization. These are panel data with industrialization measured in 1960 and 1965 and political democracy measured in 1960 and 1965. For industrialization, the indicators in 1960 are gross national product per capita (GNPPC60), energy consumption per capita (ENPC60), and percentage of labor force in industry (INDLF60). For political democracy, the same indicators are used in 1960 and 1965: freedom of press (PRESS60, PRESS65), freedom of political opposition (FREOP60, FREOP65), fairness of elections (FREEL60, FREEL65), and effectiveness of elected legislature (LEGIS60, LEGIS65). The model proposed by Bollen (1989, p. 324) in equating the loading coefficients of political democracy indicators and correlating their error terms is used here for illustration. More details about the capabilities of each software package for single-group analysis can be found in Section 5 of the online supplementary materials.

The results of analyses using all the eight packages for the political democracy data are identical within two decimal places. The only difference seems to be in the error variance estimates where some packages use the default as maximum likelihood (ML) estimates and other packages use unbiased estimates. This has the effect of using N or N − 1 in the denominator for variance estimates. Some packages allow the user one to change the default while others do not. For example, in Amos, this can be changed using View → Analysis Properties → Bias → Covariances To Be Analyzed; in lavaan, the likelihood = <argument> can be used when calling the fitting function.

6. CAPABILITIES FOR MODEL EVALUATION

Once the parameters are estimated, the specified model can be tested using the minimum fit function value. Using the unbiased estimator for the sample covariance matrix, the following statistic can be computed for model evaluation for a single-group analysis:

\[ T = Q_{\text{min}}(N - 1). \]

Under the appropriate choice of W in (5) and the correctness of model in (4), T has an asymptotic chi-squared distribution, which can be used to test the proposed model. While the overall test statistic T has been widely used for model evaluation, it has at least two limitations: one is the sensitiveness to sample size where even trivial differences can be amplified by a large sample size leading to the rejection of the proposed model; and the other is the rigid hypothesis testing framework of representing a model that usually has some misspecification. For these and other reasons, there are many other goodness-of-fit indices that have been proposed in the literature. These supplemental fit indices can be broadly divided into absolute fit indices (with no reference model) and incremental fit indices (in comparison with a target model). Hu and Bentler (1999) investigated the performance of several of these indices and recommended a multiindex strategy with appropriate cutoff values for indices in each class. While many users had long waited for such guidelines for model testing, Marsh, Hau, and Wen (2004) pointed out that such guidelines cannot be taken as “golden rules” under all situations. Under such conditions, a safe rule might be to look at several types of fit indices and evaluate the model in totality. Currently, different software packages report different number of fit indices. While LISREL and SAS PROC CALIS report a broad range of fit indices, Mplus and R packages sem and OpenMx report relatively fewer indices. However, for R users, it is possible to compute these missing indices from the model object, which contain the relevant information. Among the incremental fit indices, naming convention is not standard. While some packages report them as Bollen normed index (Rho1) and Bollen nonnormed fit index (Delta2), other packages report the same indices as relative fit index (RFI) and incremental fit index (IFI). The Tucker Lewis index (TLI) is also sometimes referred to as nonnormed fit index (NNFI). For ML estimation, the model chi-squared value is reported in two different ways. In Mplus and lavaan (default setting), they are reported based on sample size N using the normal likelihood approach, whereas in other packages, they are reported based on N − 1 using the Wishart likelihood approach. In LISREL, the independence model chi-squared and the related fit index (such as normed fit index) depend on estimation method and normality assumption. Details on how the selection is made are given in a technical report (http://www.ssicentral.com/lisrel/techdocs/tlb.pdf). There is also a discrepancy in the reporting of Hoelter’s N, which is the largest sample size for which the model is not rejected. LISREL reports the value at a significance level of 0.01, SAS PROC CALIS reports at a significance level of 0.05, and Amos reports values at significance levels of 0.05 and 0.01. Besides these minor variations, all fit indices (other than information

The American Statistician, May 2012, Vol. 66, No. 2 131
Table 1. Selected fit indices of several SEM packages for single-group analysis

<table>
<thead>
<tr>
<th>Fit indices</th>
<th>Amos</th>
<th>SAS PROC CALIS</th>
<th>R package sem</th>
<th>R package lavaan</th>
<th>R package OpenMx</th>
<th>LISREL</th>
<th>Mplus</th>
<th>EQS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall indices</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model chi-square</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Baseline chi-square</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Fit function value</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>Incremental fit indices</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NFI (Delta1)</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>NNFI (or TLI)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>IFI (or Delta2)</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>CFI</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Information theory based</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AIC</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>CAIC</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>BIC (or SBC)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>General</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GFI</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>RMSR</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>SRMR</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Hoelter’s N (0.05)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>RMSEA</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Parsimony fit indices</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AGFI</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>PGFI</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
</tbody>
</table>

CFI, comparative fit index; AIC, Akaike information criterion; CAIC, consistent AIC; BIC, Schwarz’s Bayesian criterion; SBC, Schwarz’s Bayesian criterion; GFI, goodness-of-fit index; RMSR, root mean square residual; SRMR, standardized root mean square residual; RMSEA, root mean square error of approximation.

7. CAPABILITIES FOR MULTIPLE-GROUP ANALYSIS

Multiple-group analysis in SEM is used to test for model equivalence across groups. In the measurement context, multiple-group analysis can be used to test for measurement invariance across groups (e.g., do men and women assign the same meaning to measurement of a construct such as intolerance). While all the packages reviewed here (including SAS PROC CALIS) can handle true multiple-group situations by maximizing a composite fit function, the sem package in R can only handle single-group analysis. However, in the special case of equal sample size, the sem package in R can be made to handle multiple-group analysis by creating a block diagonal covariance matrix where the blocks are the individual covariance matrices. The fit function is the sum of the fit in each group. Dividing this function by the number of groups yields a value needed for multiple groups (Evermann 2010). The degrees of freedom and certain fit indices, which are functions of degrees of freedom, need to be recomputed.

7.1 Description of Data for Multiple-Group Analysis

This example is taken from the Amos 18.0 user’s guide (example 12). In this example, it is hypothesized that visual perception (visperc), spatial visualization (cubes), and spatial orientation (lozenges) measure spatial ability (spatial); paragraph completion score (paraprag), sentence completion score (sentence), and word meaning test score (wordmean) measure verbal ability (verbal). Data from 72 girls and 72 boys were taken to test measurement invariance across these two groups (the last observation from the original data for girls was dropped to equalize the sample size across the two groups to accommodate the sem package in R).

A nested hierarchy of models was tested for measurement invariance across the two groups. This ranged from a completely unconstrained model to a completely constrained model of equal loadings, equal factor covariance matrix, and equal error variances. All software packages gave very similar estimates to at least two decimal places accuracy. The same capabilities of single-group analysis (Section 5) are also available in multiple-group analysis in terms of graphical and programming options for all the software packages. Figure S4 (see the online supplementary materials) shows how multiple-group modeling can be completed in LISREL using the path diagram by creating a SIMPLIS project. The top half of the figure shows a part of the SIMPLIS syntax and the bottom half shows a dialog box for setting different constraints for testing different levels of measurement invariance. To facilitate model fit across groups, SAS PROC CALIS provides a comparison table, which is shown in Table S1 (see the online supplementary materials). Such a table is useful to compare fit across groups with overall fit. In addition, LISREL, Mplus, and R package lavaan also report the chi-squared contribution from each group to assess the fit (or misfit) in each group. All comments regarding fit indices made in the previous section on single-group analysis also apply to multiple groups. In LISREL models, the parsimony fit indices [adjusted goodness-of-fit index (AGFI), parsimony...
goodness-of-fit index (PGFI)) are not defined in the multiple-group situation.

8. CAPABILITIES FOR HANDLING NONNORMAL VARIABLES

While the ML method of estimation assumes multivariate normality, there are at least three options available in many SEM software packages to handle nonnormal observed variables: (1) asymptotically distribution-free (ADF) estimators, (2) scaling corrections to fit statistics and standard errors based on ML estimation, and (3) bootstrapping.

8.1 ADF Estimator

Given the prevalence of nonnormal data in practice, Browne (1984) developed the ADF estimator that does not make assumptions about normality. While theoretically appealing, there are practical limitations with the ADF estimator. Empirical research has shown that ADF estimator does not perform well unless the sample size is very large ($n \geq 5000$). Also, the method is somewhat computationally demanding since it requires computing the inverse of a weight matrix of size $(p + q)(p + q + 1)/2$, where $p + q =$ number of the observed variables. Due to the practical limitations, ADF estimator has not become a viable alternative.

The ADF estimator is sometimes called the weighted least squares (WLS) approach in many software packages. In LISREL and Mplus, the WLS method of estimation has to be specified, along with continuous observed variables, to obtain ADF estimators. In LISREL, a two-step process is used to obtain the ADF estimator; a preprocessor called PRELIS should be used to obtain the weight matrix using the raw data. In a second step, the weight matrix and the covariance matrix (or raw data) are used to compute the ADF estimator. Table 2 shows the capability of various software packages in terms of ADF estimator and other nonnormal options discussed below. In EQS, there are other classes of estimators to deal with nonnormality: elliptical theory estimators (for distributions that are homogeneously kurtotic), heterogeneous kurtosis theory estimators, and case-robust estimators (differentially weights individual observations). For more details on these estimators, refer to EQS program manual (Bentler 2006).

8.2 Scaling Correction to Fit Statistic and Standard Errors

Another method of dealing with nonnormal data is to scale the fit indices and standard errors of parameter estimates by a scaling factor that is determined by the amount of nonnormality in the data, particularly the kurtosis. This scaling procedure (sometimes called the Satorra–Bentler scaling method) is typically used with ML estimation, thus alleviating the computational problems associated with ADF estimation. In the nonnormal situation, the parameter estimates are usually not biased and are not scaled (Finney and DiStefano 2006). The usual chi-squared difference test for nested model comparison is not applicable here; Satorra and Bentler (2001, 2010) gave formulas to make this comparison using standard results from SEM software. Similar to ADF estimation, the LISREL software requires the two-step approach with a preprocessing step using PRELIS.

8.3 Bootstrapping

A third method of dealing with nonnormality is bootstrapping, where the original data are used as the parent data for repeated sampling with replacement. In SEM, there are two types of bootstrapping: the na"ıve bootstrapping and the Bollen–Stine bootstrapping. The na"ıve bootstrapping is the typical bootstrap method used for computing standard errors of parameter estimates. Bollen and Stine (1992) noted that the na"ıve bootstrapping is not appropriate for the model fit statistic or the associated $p$-value since the covariance structure in the parent data is not consistent with the null hypothesis. Transformation of the original data is required so that the covariance structure is consistent with the null hypothesis and the generated values reflect only the sampling variability and nonnormality and not model misfit. The empirical distribution of model fit statistic is then used as a reference distribution (instead of the theoretical chi-squared distribution) to obtain the corrected proportion of samples that exceed the computed statistic of the parent sample.

Bootstrapping capability in SEM software is generally not well known and is rarely used. This capability in SEM software packages should be exploited since many linear multivariate models such as regression, simultaneous equation, path analysis, and canonical correlation can be considered as special cases of SEM. Even simple correlation analysis can be conducted as a saturated confirmatory factor analysis (Fan 2003). SEM

---

Table 2. Table of options for handling nonnormal variables and other types of estimators in SEM packages

<table>
<thead>
<tr>
<th>Nonnormal options and other estimators</th>
<th>Amos</th>
<th>SAS PROC CALIS</th>
<th>R package sem*</th>
<th>R package lavaan</th>
<th>R package OpenMx*</th>
<th>LISREL</th>
<th>Mplus</th>
<th>EQS</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADF estimator</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Robust standard error</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Naive bootstrap</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Bollen–Stine bootstrap</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Other estimators</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ML</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Unweighted least squares</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Generalized least squares</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Diagonally weighted least squares</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Two-stage least squares</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
</tbody>
</table>

*In sem, the user can supply an objective function to be minimized.

*In OpenMx, package users can write their own objective functions.
software packages vary in the degree of automation with which bootstrap capability is implemented. Amos and EQS seem to offer a number of choices regarding bootstrap capability. To perform bootstrap using Amos graphics mode, after the model is specified, choose View → Analysis Properties and select the bootstrap tab. The resulting window with different options is shown in Figure S5 (see the online supplementary materials). The Perform Bootstrap option should be checked and when the estimates are computed, the bootstrap computations take place at the same time. Nonconvergent solutions are automatically rejected until valid bootstrap samples for the requested number are obtained. The results can be viewed under View → Text Output.

In EQS, bootstrap can be done using the simulation option of the Build_EQS menu. The options under Type of Simulation include regular bootstrap (naïve), model-based bootstrap (Bollen–Stine), and jackknife. Once the options are selected, the Build_EQS menu automatically populates the syntax window. In LISREL, bootstrapping can be done using Statistics → Bootstrapping and choosing Output Options to save the results. In lavaan, bootstrapping can be done using the bootstrapLavaan function. In Mplus, bootstrapping can be done using the BOOTSTRAP option in the ANALYSIS command. In SAS PROC CALIS, bootstrapping is not implemented, although the naïve bootstrapping can be implemented via user-written macros.

9. CAPABILITIES FOR HANDLING MISSING DATA

A practical challenge when using multivariate data is handling missing data issues. Similar to bootstrapping capabilities, SEM software packages offer a number of options for handling missing data. These include not only the traditional methods such as listwise and pairwise deletion, but also more modern methods such as full information maximum likelihood (FIML) and multiple imputation (MI). Since many of the standard linear multivariate models can be cast in a latent variable framework, SEM software packages offer an ideal platform to handle missing data. The latent variable modeling framework also allows for easy incorporation of auxiliary variables into the model, which helps mitigate bias and improve efficiency in the presence of missing data (Enders 2006).

9.1 Full Information Maximum Likelihood (FIML)

Under the assumption of normality, this method computes ML estimates in the presence of missing data. Amos was one of the first software packages to implement FIML in SEM (Arbuckle 1996) and since then, many other SEM packages have implemented this option. Missing data introduce some nuances into FIML estimation. To begin with, raw data are needed for computing individual log-likelihoods as opposed to inputting a covariance matrix, which is typical in complete data analysis. Second, standard error computations require special attention; observed information and expected information can produce diverging results and studies have shown observed information to be a better choice for FIML estimation under the missing at random (MAR) mechanism (Enders 2010).

An advantage of using SEM software packages for missing data is the ability to incorporate auxiliary variables into the model. An auxiliary variable is a variable that is not of substantive interest in the analysis but is a potential correlate of missingness in the model. Inclusion of this variable helps to satisfy the assumption of MAR and also helps in mitigating the bias and improving efficiency (Enders 2010). Among the packages reviewed here, Mplus and EQS are the only packages that have the ability to include auxiliary variables in the analysis for handling missing data.

Many of the other packages also make the FIML missing data analysis fairly straightforward with minimal changes compared with a complete data analysis. For example, using the graphics mode in Amos 18, once the model is specified, FIML can be implemented by selecting View → Analysis Properties → Estimation Tab (choose Means and Intercepts) → Output Tab (choose Observed Information Matrix). In LISREL, FIML is implemented by default whenever the raw data matrix is analyzed and a missing value code is specified. LISREL also supports a variant of hot-deck imputation by matching the response patterns of incomplete and complete data. The PRELIS manual (Jöreskog and Sörbom 1996c) gives complete details of the algorithm. In EQS, FIML can be chosen with the option MISSING = ML in the /SPECIFICATIONS section in the syntax (or via Build_EQS → Title/Specification → Missing data handling). EQS also offers a range of missing value options available, including listwise, pairwise, regression, stochastic regression imputation, and diagnostic plots of missing data patterns. SAS 9.22 and later offer FIML as an option within PROC CALIS, which is easy to implement. With SAS 9.3, PROC CALIS also offers additional missing data diagnostics such as coverage proportions and dominant missing patterns and their summary statistics, which could help identify problematic variables. In lavaan, FIML can be invoked using the missing = <FIML> option. In Mplus, type = missing in the ANALYSIS section invokes the FIML method.

9.2 Multiple Imputation (MI)

Unlike FIML, MI creates multiple copies of the data by filling in the missing values in each copy with different estimates. These multiple copies of complete datasets are analyzed separately and the resulting estimates are pooled to a single estimate using rules outlined by Rubin (1987). SEM software packages differ in the number of options available in the three stages of imputation, analysis, and pooling.

The analysis and pooling phases are currently offered only in Mplus, which seems to be the only software to offer all three phases of MI. Currently, LISREL and Amos offer the option of generating multiply imputed datasets that can be read into Mplus or other programs. In Amos, MI can be done using Analyze → Data Imputation. Amos 18.0 offers regression imputation, stochastic regression imputation, and Bayesian imputation. Amos offers imputation based on any constrained model such as a confirmatory factor model. According to Amos 18.0 user’s guide, the estimates will be more accurate than the saturated model and estimates of latent variable scores are also obtained. The analysis and pooling phases are not automated in Amos.
LISREL, MI can be done once the raw data are converted into a PRELIS System File by choosing Statistics \(\rightarrow\) Multiple Imputation. The imputed values can be stored in an external file and multiple copies of imputed data are stacked into the same file. Similar to Amos 18.0, the analysis and pooling phases are not automated; however, the estimates based on any constrained model can be output to a separate file and simple summary statistics of these estimates can be computed. Details are given in technical documents available at the vendor’s website (http://www.ssicentral.com/lisrel/resources.html).

Another option is to use SAS PROC CALIS in combination with SAS PROC MI (to generate imputed datasets) and SAS PROC MIANALYZE to analyze and pool the results (Zhang and Yung 2011). While there is some extra work involved in programming these steps, this option allows all three phases, including graphical convergence diagnostics and multiple parameter significance testing, which makes SAS a complete package for MI using SEM.

Finally, the assessment of fit when pooling results from multiple datasets is an area that has not been well explored. Consequently, there are no rules for assessing fit other than combining the likelihood ratio tests as outlined by Enders (2010). In terms of implementation, MI is more involved than FIML, which is usually invoked as an option or a method of estimation. However, MI is more general since the imputed datasets are not tied to SEM or any specific model. For a detailed comparison of the two methods in the context of SEM, see Enders (2010).

Table 3 gives a comparison of MI and FIML estimates for the girls’ data of the multiple-group analysis in Section 7. The MI estimates were computed using SAS PROC MI (for imputation), PROC CALIS (for analysis), and PROC MIANALYZE (for pooling) based on 50 multiply imputed datasets. The data are taken from Amos user’s guide (example 17) where missing values were generated at random. The estimates from complete data are also shown for comparison. Given that approximately 27% of the data are missing and only 7 out of 73 cases had complete data, the MI and FIML estimates are not too far away from the complete data analysis for most of the estimates. With missing data, some of the fit indices that depend on the saturated model and the independence model are not reported in some packages.

### 10. CONCLUSIONS

This article has presented a review of eight software packages for linear SEM, including capabilities for handling single-group analysis, multiple-group analysis, nonnormal variables, and missing data handling. All packages produce estimates that are fairly close to each other in accuracy (up to two decimals). The main difference between the packages comes in the user interface and the availability of different options; while Amos, LISREL, and EQS can be used in programming mode and graphical interface, the rest of the packages can only be used in a programming environment. SAS PROC CALIS and lavaan currently do not render path diagram output. With R packages sem and OpenMx, it is possible to produce a path diagram through graphviz or other third-party applications.

Each package has its own strengths and special features as shown in Table 4. Users of SEM may choose one package over the other based on the special features needed for a particular application or the computing environment they are already familiar with based on other applications. While the R packages (sem, lavaan, and OpenMx) are attractive for users who prefer open source environments, rapid developments are also taking
Software Strengths Special features
---
Amos Excellent graphical interface Integrating other analysis capabilities available in SAS (e.g., MI for missing data analysis) Bayesian estimation in a limited way
Well-organized and quickly accessible output format Well-organized and quickly accessible output format Several options for bootstrapping
SAS PROC CALIS Integrating other analysis capabilities available in SAS (e.g., MI for missing data analysis) Incorporation of two-stage least squares for econometric modeling; ability to create path diagram via graphviz Specification search in the absence of theory
R package sem Open source environment with complete features of R including graphics capabilities Ability to compute two different likelihoods for ML estimation (normal and Wishart) Flexibility of model specification in many different formats such as COSAN, FACTOR, LINEQS, MSTRUCT, and RAM
R package lavaan Open source environment with complete features of R including graphics capabilities Compact scripting even for complicated models Ability to “mimic” Mplus and EQS results
R package OpenMx Open source environment with complete features of R including graphics capabilities Integrate with other R packages to enable multicore processing and large-scale distributed processing Ability to optimize user-specified objective functions
LISREL General linear modeling software for SEM, multilevel modeling, generalized linear modeling, and recursive modeling Estimation of observational residuals in factor analysis and structural equation models
Mplus Integrated modeling framework to handle continuous, categorical, observed, and latent variables; incorporation of latest missing data handling methods Incorporation of auxiliary variables for missing data handling. Easy implementation of interaction effects among latent variables. Unique capability including Bayesian SEM, exploratory SEM, handling of count and censored values, and missing data under not missing at random (NMAR) mechanism
EQS Structural modeling made simpler by offering different ways to create models; more capability for exploratory analysis Ability to compute multivariate Lagrange multiplier and Wald tests Unique capability for handling nonnormal variables in complete and missing data situations

Software Strengths Special features
---
LISREL General linear modeling software for SEM, multilevel modeling, generalized linear modeling, and recursive modeling Estimation of observational residuals in factor analysis and structural equation models
Mplus Integrated modeling framework to handle continuous, categorical, observed, and latent variables; incorporation of latest missing data handling methods Incorporation of auxiliary variables for missing data handling. Easy implementation of interaction effects among latent variables. Unique capability including Bayesian SEM, exploratory SEM, handling of count and censored values, and missing data under not missing at random (NMAR) mechanism
EQS Structural modeling made simpler by offering different ways to create models; more capability for exploratory analysis Ability to compute multivariate Lagrange multiplier and Wald tests Unique capability for handling nonnormal variables in complete and missing data situations

The same idea would also be helpful to compare models in single-group analysis. The anova() function in R is also useful in this respect.

The MplusAutomation package in R (Hallquist 2011) is useful for postprocessing results from Mplus by extracting and tabulating parameters and fit indices. The package can read output from several directories, extract summary information, and display them in a concise tabular form. An example of such a display for a series of nested models testing measurement invariance from the multiple-group example in Section 7 is shown in Table S2 (see the online supplementary materials). The reqs package is a similar interface between R and EQS to call, execute, and read results from EQS into R for further processing. Mair, Wu, and Bentler (2010) showed how to combine the best of both “worlds” by studying the effect of normality violations on the distributions of test statistics and power analysis for a structural parameter. These examples show how to combine the powerful computational and graphical capabilities of R with the unique implementation in some of the SEM software packages. A trend in the future may be more integration of SEM software packages with R statistical computing environment. Such integration would allow for methodological developments to take place rapidly.

SUPPLEMENTARY MATERIALS
Section 2: Eight structural equation modeling (SEM) packages (contd.)
Section 3: Documentation
Section 4: Data management and data entry
Section 5: Capabilities for single-group analysis (contd.)
REFERENCES


Blunch, N. J. (2008), Introduction to Structural Equation Modeling Using SPSS and Amos, Boca Raton, FL: Chapman & Hall/CRC. [Supplement]


——— (2010), Applied Missing Data Analysis, New York: Guilford Press. [134,135]


